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“A jury consists of twelve”
persons chosen to decide

“who has the better lawyer.”
— Robert Frost

Introduction

 It’s easy to fall behind the times in terms 
of technology. Keeping up with the Jone-
ses can be confusing, time-consuming 
and expensive. Every generation of kids 
grows up with the latest technology and 
is more comfortable using improvements. 
I’ve always considered myself relatively 
tech-savvy, but even I’m getting behind 
the eight-ball. My last game system was 
the Nintendo 64 from 1996 (Has it been 
so long?). I’ve never even touched an iPod, 
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while my 20-year-old brother has gone 
through all of Apple’s variations.
 But no matter how far behind the times 
you are, there are plenty of opportunities 
to catch up and to stay competitive. You 
may have to ask your children, nieces and 
nephews to demonstrate the complexities 
of web design, but, as a matter of prin-
ciple, you should be able to set the time 
on your own VCR. 
 Here are ten technology tips (many are 
free!) to make you more efficient in your 
legal work:

Tip No. 1: Make Your E-mail System 
Work For You

 Whether you use Outlook, Netscape, 
Yahoo, or G-mail, there are plenty of 
options available to make life easier. It is 
to your advantage to learn the bells and 
whistles of each program. For purposes 
of illustration, this article will refer to 
Microsoft Outlook 2003, one of the 
more common e-mail systems used in 
businesses.

 A) Sort: You can sort e-mail in a num-
ber of ways that are convenient. In 
Outlook, click on the gray column 
headings above the message list to 
sort by common features such as 
the sender, and date received (or, 
click the “Arrange by” button on 
the “View” drop-down menu). 
Additionally, you can segregate the 
messages you’ve responded to from 
the ones you haven’t, or you can 
organize according to the priority 
you have assigned to messages. 

 B) Search: If you can’t find an e-mail by 
sorting based on the sender or date 
received, try a search (in Outlook, 
this is done through the “Find” 
button on the “Tools” drop-down 
menu). Type a word that is some-
what unique to the message you are 
looking for, specify which folder 
you want to search, and you should 
come up with a list of messages that 
pertain to your subject.

 C) Rules: Perhaps the most overlooked 
feature of e-mail systems are rules. 
These sound complicated, but they 
are in fact very intuitive, and vital 
to streamlining your overloaded in-
box. You can use rules as a second 
line of defense from spam (i.e., send 
all e-mail messages with “Cialis” or 
“Viagra” in the subject line or mes-
sage body to the junk e-mail folder 
– although this might not be a good 
idea if you are a pharmaceutical at-
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torney). Or, it can keep you more 
organized (i.e., send all listserve 
messages to a certain folder so they 
don’t clog your in-box and you 
can look at them later, or send all 
messages from a particular person 
or client to a specific folder). To 
create a rule in Outlook, simply 
click “Rules and Alerts” from the 
“Tools” drop-down menu, click 
“New Rule,” and use the templates 
to create your rule. 

 D) Spell-check: Your e-mails should be 
as professional as your letters. You 
wouldn’t send a letter out without 
checking the spelling, and e-mail 
etiquette requires that you do the 
same for your e-mails. Most e-mail 
systems are equipped to spell check 
e-mails before they get sent. Do this 
as a favor to all your readers! Click 
“Options” in the “Tool” drop-down 
menu. Go to the “Spelling” tab and 
click the box marked “Always check 
spelling before sending.”

 E) Follow-up: If you can’t address 
an e-mail message right away, but 
know it is important, put an alert 

on it. In Outlook, simply click the 
“Actions” drop-down menu and 
click “Follow-Up” and “Add Re-
minder.” Put in the date and time 
for the alert, and you will receive 
a message at that date and time, 
reminding you about the e-mail. 
This is an important way to prevent 
your e-mails from being lost in the 
shuffle of your in-box. Additionally, 
if you want to remind yourself to 
follow-up on an e-mail message you 
send out, use the same procedure 
in a new message before you click 
“Send.”   

Tip No. 2: Stop Ordering Paper
Transcripts From Your Court 

 I’m not here to tell you to make your 
entire office paperless; paper is part and 
parcel of the legal business. However, 
there is absolutely no good reason to 
order a full-sized or condensed (“mini”) 
manuscript of depositions from your 
court reporter (unless you noted the de-
position and are in charge of the “official” 
copy). Save yourself and your client the 
money. The only thing you need to order 
is an E-Transcript and an ASCII. With an 

E-transcript and an ASCII, you can do 
as much and more than you could with 
a simple paper transcript. A little back-
ground–ASCII (pronounced “ask–ee”) 
stands for American Standard Code for 
Information Interchange. If you have a 
computer, you can use it. It is a very basic 
program that displays text. Usually it will 
come up on your computer as a Notepad 
(look in your Accessories file on the Start 
menu). From here, you can search text 
(Ctrl-F) very quickly during trial on your 
laptop, and you can copy text and paste it 
into your briefs. 
 E-transcript is a proprietary program 
used by 70% of court reporters.1 A free 
viewer is downloadable from http://www.
reallegal.com/eTranscript.asp. Once you 
have that on your computer, you are ready 
to go! E-transcript provides an easy way to 
read, print, and search transcripts. From 
this program, you can print full-size and 
mini deposition transcripts, including 
the word index. You can view an index of 
words that appear in the transcript, and 
by clicking on any word in the index it 
will take you directly to the word in the 
transcript. Other versions with additional 

1 http://www.reallegal.com/eTranscript.asp
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features are available for purchase, but the 
free version is absolutely essential for any 
lawyer. 
 As an additional bonus, both of these 
electronic transcripts merge seamlessly 
with TextMap, a program put out by 
Lexis Nexis CaseSoft, which can be used 
to create incredibly useful deposition sum-
maries.2 At the end of the deposition, just 
ask the court reporter for an E-tran (that’s 
the lingo, if you want to appear “cool”) 
and ASCII to be e-mailed directly to you 
and/or your assistant. 

Tip No. 3: Use Instant Messenger

 Instant Messenger (“IM”) is e-mail 
with adrenaline: it allows two or more 
people to have an actual typed conversa-
tion over the computer. There are plenty 
to choose from, including MSN, AOL, 
and Yahoo! If you have a laptop computer 
with wireless capability, or if you are able 
to hook up to the Internet while at trial 
or at a deposition, you can instantly com-
municate with your associates, assistants, 
and experts. Need a document that you 
didn’t bring with you? IM your assistant, 
and have him e-mail it to you, or send it 
directly through the instant messenger 

program. Need more information on 
a particular point the defense expert is 
making? Instant message your expert, and 
find out the lynchpin of his analysis. Also, 
if you want your remote associates and 
experts to be able to read the deposition as	
it	proceeds, ask your court reporter about 
LiveNote’s Realtime Internet Service.3 

Tip No. 4: Get A Projector

 Let’s face it, in this day of multimedia, 
jurors are not interested in listening to 
any of us talk. And, if you do, you need 
something visual that gives the jury a 
reason to remember it. If you are a trial 
lawyer, you need a projector. Projectors 
have many uses: showing demonstrative 
evidence to the jury, playing a critical 
deposition segment to the mediator, or 
giving a presentation to the office. 
 What specifications should you get? 
Your projector should have a capacity of 
at least 1000 lumens (a measure of the 
brightness capability). The higher the 
lumens, the easier it is to see the projec-
tion, even in a well-lit room. Unless you’re 
a connoisseur, the differences between an 
LCD and DLP projector are not likely 
to be significant, but talk to your retailer 
about your anticipated projector uses. A 
basic projector can be purchased for under 
$1,000.
 Of course, the projector will need a 
screen ($100 to $200 for a basic ver-
sion; find something that shrinks down 
that you can travel with and display in a 
courtroom), and it is important to make 
sure you have the proper cables to connect 
your laptop to the projector. Most projec-
tors and laptops communicate through a 
USB cable, which is the standard technol-
ogy hook-up. All of these components are 
available at your local office supply store. 
You can also connect a digital presenter 
(like an overhead projector, except that 
it can project regular paper and objects 
instead of transparencies) directly to the 
projector.4 Always make sure to test your 
presentation a couple of days before you 
need it. 

Tip No. 5: Use Videoconferencing 
For Your Depositions

 Videoconferencing is not just for big 
corporations anymore. As the technol-
ogy has advanced, it has become more 

2 http://www.casesoft.com

3 h t tp : / /www. l i v eno t e . com/ s e r v i c e .
asp?service=2#faqs

4 See	 www.samsungpresenter.com for one ex-
ample of a digital presenter.

Core Funding Group, L.P.

Since 1991, Core Funding Group, L.P. has 
provided over $150 million dollars in funding 
to law fi rms.

You’re welcome at Core Funding regardless 
of the size of your fi rm. So, whether you need several 
thousand dollars or several million dollars, 
Core Funding can help.



Summer	�006	 Trial Reporter	 �9

Telecommunications
Voice over IP

Digital Recording 
Digital Dictation 

Systems 

& Certified Since 1972 

(410) 785-1600
Serving 

 Maryland – North 
Virginia – D.C. – 

Pennsylvania 

10955 Golden West Drive
Hunt Valley, MD

21031

accessible and affordable for even smaller 
firms. In some cases, it can actually save 
you money. 
 Essentially, you need two video-
conferencing locations. Kinko’s has 
videoconferencing sites available in every 
major city, and larger court reporters, such 
as LAD Reporting, Art Miller & Associ-
ates, and Esquire Deposition Service all 
have these capabilities, as well. If you are 
videoconferencing a deposition, it makes 
sense to go through your court reporter 
for the transcription and videoconferenc-
ing components. 
 How much will this cost you? Video-
conferencing typically ranges from about 
$200 to $350 per hour per site. Compared 
to a round trip plane ticket, time spent 
out of the office, meals, and even hotel 
charges, it might be wiser to videocon-
ference a deposition than to travel to 
the deposition location. Of course, some 
depositions you should go to in person, 
when you can. Typically, the defendant 
and key fact witnesses should be deposed 
in person. Witnesses who will be asked 
to examine or refer to a large number of 
documents may be easier to depose in 
person. However, a defense expert who 
is prepared appropriately will likely be 
immune to the additional pressures that 
come to bear in a live deposition, so video-
conferencing may be to your advantage. 
 Note also that a deposition done by 
videoconference	is not the same thing as a 
videotaped	deposition. Not all videocon-
ferences are recorded, and you should 
determine if any special measures need to 
be taken in order to play a recorded de-
position. Maryland Rule 2-416 contains 
numerous requirements for the operator 
of a videotaped deposition, including 
stating his name, employer, date and time 
of deposition, caption of case, deponent’s 
name, and name of the party giving 
notice on the tape. Md. R. Civ. Proc. 
§2-416(f ) and (g). Likewise, the operator 
must attach a certificate that it is a correct 
and complete record of testimony given. 
Great care must be taken to ensure that 
the videoconferenced deposition may be 
used at trial. 

Tip No. 6: Get A Desktop 
Searching Program 

 We’ve all had that sinking feeling 
when, after searching every folder on your 
computer for the final version of the brief 
you worked on a month ago, you come 
up empty-handed. It’s always in the last 
place you look. Now there is a way to 
cut down your search time. Download 
a free desktop searching program, such 

as Google Desktop (http://www.google.
com/downloads/) or Copernic (http://
www.copernic.com/). With it, you can 
search your entire hard drive for e-mail, 
files, documents, folders, and anything 
else that is saved on your computer, in-
cluding your Internet history. This brings 
the ease and efficiency of an Internet 
search to your hard drive. 

Tip No. 7: Upgrade From Adobe Reader

 Adobe Reader is free software available 
at www.adobe.com. The creators have 
distributed over 500 million copies of the 
program, so chances are that it is on your 
computer right now.5 It offers the ability 
to view, print, and even to search PDF 
documents, albeit to a limited extent. 
 The Adobe family includes Acrobat 
Professional, and Acrobat Standard. Ac-
robat Professional has more features than 
Acrobat Standard, but the version you 
use depends on your firm’s requirements. 
Here are some features that you may not 
know about:

 A) Use the “Snapshot” tool to select 
and copy a portion of an Adobe 
document. Paste it into another ap-

plication, such as onto PowerPoint 
slide. 

 B) Re-arrange pages within a docu-
ment, or insert pages from one 
Adobe document to another. Sim-
ply click the “Pages” tab on the left 
side of the screen, select a page or 
pages, then move your cursor to the 
insertion point of that or another 
Adobe document.

 C) Create new PDF documents from 
WordPerfect: click the “File” drop-
down menu, and click “Publish to 
PDF.” 

 D) Create new PDF documents from 
Microsoft applications (Word, 
Excel, Outlook) by clicking the 
“Convert to Adobe PDF” icons on 
the toolbar or in the “Adobe PDF” 
drop-down menu.

 E) Create new PDF documents from 
Microsoft Explorer by clicking on 
the “Convert current web page to 
an Adobe PDF file” icon on the 
toolbar. 

 F) Conduct a presentation using only 
Acrobat by clicking “Full Screen” 
on the “View” drop-down menu. 
This omits the toolbars and cre-

5 http://www.adobe.com/products/acrobat/
acrrfaq.html
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ates a linear presentation, much 
like PowerPoint, that is suitable for 
showing to a jury or mediator. 

 G) Search within PDF documents: 
click the “Document” drop-down 
menu, click “Recognize text using 
OCR,” and click “Start.” Once the 
process is finished, you can search 
for text within a PDF document 
by clicking “Find” on the “Edit” 
drop-down menu. 

 Acrobat enables you to make com-
ments and notes directly on the PDF 
document, to share comments with oth-
ers across e-mail, to organize documents 
using bookmarks, and to create forms. 
It is a dynamic product with incredible 
potential for the educated user.

Tip No. 8: Use A Case Presentation 
Program (i.e., Trial Director, Sanction)

 Adobe and PowerPoint are useful for 
presenting information during opening 
statements and closing arguments. How-
ever, in document-intensive cases, such as 
medical malpractice, commercial cases, 
or personal injury cases with extensive 
medical records, you may need trial pre-
sentation software with more capabilities 
than Adobe or PowerPoint can provide. 
For example, if you are cross-examining a 
witness who begins to discuss something 
you were not prepared to address at that 
moment, it takes precious time for you 

to fumble with your computer to find 
the slide or document you need. Case 
presentation programs like Trial Director 
and Sanction are equipped to handle the 
uncertainties of trial. Using these systems, 
the first step is to scan all of your case 
documents into the computer. Each group 
of documents will have a specified prefix 
code, and each document will have an 
individual identification number. When a 
witness addresses something out-of-turn, 
these case presentation programs can 
instantly access the document you need, 
and can magnify, highlight, and mark up 
documents on the “big screen” for the 
jury. This provides for a more interactive 
examination that will, at the very least, 
keep the jury interested. 
 Single-user licenses can be ordered on-
line from www.sanction.com and www.
trialdirector.com for about $600 each.
 
Tip No. 9: Scan Your Documents

 Creating an internal document scanning 
system can make you more productive. If 
you are doing some last-minute early-
morning deposition preparation out of 
the office, you can still access docu-
ments even when your colleague is home 
asleep. 
 By investing in a relatively inexpensive 
high-speed scanner, you can convert 
mounds of documents into PDF or TIF 
formats. The originals may be disposed 
of or, if that is too nerve-racking for you, 
at least filed away in an unused corner 

of the office. These documents, when 
scanned and saved onto your server, are 
accessible to the entire office at the same 
time, can be copied quickly to your hard 
drive while out-of-town at depositions 
or trial, and are ready to be e-mailed or 
printed. Additionally, a laptop computer 
and high-speed Internet connection can 
allow you to access these documents from 
home or when you are traveling. 

Tip No. 10: Google Desktop Alerts  

 If you want to keep up on current 
events regarding a certain topic, defen-
dant, corporation or witness, you can 
request Google to automatically perform 
a specified search and report the results 
to you via e-mail. Go to http://www.
google.com/alerts, type in your search 
terms and choose whether you want to 
be notified once a day, once a week, or 
instantaneously when the news comes 
in. Links to the new web pages will be 
e-mailed to you automatically. 

Conclusion

 It’s a brave, new world out there. But 
you don’t need to be an engineer, com-
puter scientist, or eight-year old to divine 
the mysteries of modern technology. All 
you need is some initiative, and a com-
mitment to give yourself and your clients 
every possible advantage.
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